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01 PUESTA EN MARCHA DE EVIEWS 

Hacer clic en el botón Inicio de la barra de tareas de Windows, seleccionar Programas, 
seguido por el grupo de programas de EViews (habitualmente EViews 3), y seleccionar 
finalmente el icono del programa (habitualmente EViews 3.1). Alternativamente, si 
existe un acceso directo al archivo EViews3.exe en el escritorio o en la barra de inicio 
rápido de Windows, hacer doble clic o clic, respectivamente, sobre él. En todos los 
casos, el icono de EViews (versión 3.1) tiene el aspecto siguiente: 

 

 

02 LA VENTANA DE EVIEWS 

Cuando el programa se pone en marcha correctamente, aparece de forma breve en el 
monitor la carátula de EViews (versión 3.1) 

 

 

 

 

seguida inmediatamente por una ventana como la que figura a continuación: 

 

 

 

 

 

 

 

 

 

 

 

 

En los párrafos siguientes se describen las cinco áreas de la ventana anterior. 

 

Barra de Título. A la izquierda, contiene el icono (botón) del programa  y el título 
EViews; a la derecha, contiene los botones típicos de Windows para minimizar , 
maximizar  o restaurar , y cerrar  la ventana. Cuando EViews es el programa 
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activo en Windows, su barra de título es, generalmente, más oscura que las barras de 
título de otras ventanas. Cuando el programa activo es otro, la barra de título de 
EViews es, generalmente, más clara; en este caso, puede activarse la ventana de 
EViews haciendo clic en cualquier punto de dicha ventana, o bien pulsando 
repetidamente ALT+TAB hasta activarla. 

 

Menú Principal. Se encuentra inmediatamente debajo de la barra de título. Si se 
coloca el puntero del ratón sobre una de las opciones del menú principal y se hace 
clic, aparece un menú desplegable; haciendo clic sobre una de las opciones disponibles 
(oscuras) del menú desplegable se selecciona dicha opción. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Observación 1: En el sistema de ayuda integrado (que se puede consultar seleccionando Help → EViews 
Help Topics ... a partir del menú principal) puede encontrarse información detallada sobre todos los 
aspectos del manejo y el funcionamiento de EViews. 

 

Ventana de Comandos. Se encuentra debajo del menú principal. EViews permite 
ejecutar una gran variedad de operaciones seleccionando las opciones adecuadas de su 
sistema de menús (partiendo del menú principal) y rellenando las cajas de diálogo 
correspondientes, o bien de forma más directa escribiendo instrucciones en la ventana 
de comandos; una instrucción escrita en dicha ventana se ejecuta tan pronto se pulsa 
la tecla ENTER. El uso de la ventana de comandos se irá explicando en clase según 
convenga; ver también el apartado 12 de este documento. 
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Línea de Estado. Se encuentra en el extremo inferior de la ventana de EViews y está 
dividida en varias secciones: 

 

 

 

 

 

 

 

La sección de la izquierda contiene en algunas ocasiones ciertos mensajes informativos 
que emite el programa; dichos mensajes pueden borrarse manualmente haciendo clic 
sobre el botón del extremo izquierdo de la línea de estado. La siguiente sección indica 
el directorio (carpeta) en el que, por defecto, EViews busca archivos de datos y 
programas. Las dos últimas secciones indican los nombres de la base de datos por 
defecto y del archivo de trabajo actual. 

 

Área de Trabajo. Es el área situada en el centro de la ventana de EViews; 
generalmente, ocupa la mayor parte del espacio asignado a dicha ventana. EViews 
utiliza el área de trabajo para presentar las ventanas que se van creando como 
resultado de distintas operaciones. Dichas ventanas pueden manipularse siguiendo las 
técnicas habituales de Windows; por ejemplo, se puede recorrer secuencialmente la 
lista de ventanas que aparecen en el área de trabajo pulsando F6 o CTRL+TAB 
repetidamente; también se puede seleccionar directamente una ventana haciendo clic 
sobre Window en el menú principal y escogiendo el nombre adecuado del menú 
desplegable correspondiente. 

 

03 CIERRE DE EVIEWS 

Seleccionar File → Exit del menú principal; alternativamente: (i) hacer clic en el botón 
 (cerrar) en el extremo derecho de la barra de título, o bien (ii) hacer doble clic en 

el icono (botón) de EViews  en el extremo izquierdo de la barra de título , o bien 
(iii) pulsar ALT+F4. Después de ejecutar cualquiera de estas acciones, el programa 
ofrece, antes de cerrarse por completo, la posibilidad de guardar cualquier trabajo que 
no se hubiera guardado con anterioridad. 

 

04 CREACIÓN DE UN ARCHIVO DE TRABAJO 

Cualquier sesión de trabajo con EViews se desarrolla manejando objetos; un objeto es 
un conjunto de información compuesto por datos y procedimientos aplicables a dichos 
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datos, agrupados en una única unidad. A su vez, EViews agrupa los objetos presentes 
a lo largo de una sesión de trabajo en contenedores o archivos, el más importante de 
los cuales es el denominado archivo de trabajo. Dado que la mayor parte del trabajo 
en EViews requiere manejar objetos que están contenidos en un archivo de trabajo 
(en adelante WF, del inglés WorkFile), el primer paso en cualquier sesión de trabajo 
con EViews consiste en crear un WF nuevo, o bien abrir uno ya existente. Las dos 
características fundamentales de cualquier WF son la frecuencia (anual, mensual, 
trimestral, diaria, irregular, ... ) y el rango (primera y última observación) de los 
datos que contiene. 

La manera más sencilla de crear un WF nuevo consiste en seleccionar, a partir del 
menú principal de EViews, File → New → Workfile... 

 

 

 

 

 

 

y proporcionar la información que se solicita en la caja de diálogo Workfile Range: 

 

 

 

 

 

 

 

 

 

Para crear un WF adecuado para resolver el ejercicio numérico que se hizo en clase al 
final del apartado 1.2 del guión de la asignatura (ver Ectr1-JAM-Guion.pdf), (1) hacer 
clic en Undated or irregular, (2) no modificar el 1 que aparece en el campo de la 
izquierda (Start observation), (3) hacer clic en el campo de la derecha (End observation), y 
(4) escribir 5 en dicho campo; la caja de diálogo Workfile Range anterior tendrá ahora 
el aspecto siguiente: 
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Observación 2: La manera de crear WFs nuevos en EViews implica que se debe conocer la frecuencia y 
el rango de los datos que se van a utilizar ANTES de introducirlos manualmente a través del teclado, 
o antes de importarlos a EViews desde algún archivo. 

Después de especificar las características del WF que se desea crear, si se hace clic en 
el botón  de la caja de diálogo anterior, aparece la ventana correspondiente al WF 
recién creado: 

 

 

 

 

 

 

 
En la barra superior figura el título UNTITLED porque el nuevo WF aún no se ha 
guardado. (Si se hace clic en el botón  de la caja de diálogo Workfile Range anterior, 
se cancela la creación del WF.) Dentro del nuevo WF, aparecen dos objetos que 
siempre figuran en cualquier WF: un vector de parámetros o coeficientes, C, y una 
serie de residuos, RESID, ambos asociados con el último modelo estimado en EViews. 
El icono a la izquierda del nombre de cada objeto sirve para identificar el tipo de 
objeto:  para un vector de parámetros o coeficientes (en inglés coefficient vector) y 

 para una serie de datos (en inglés series). 

Observación 3: Algunas reglas para especificar el rango (primera fecha y última fecha) de datos 
temporales son las sigientes: 

� Datos anuales (Annual). Especificar el año, por ejemplo 1996, 2002, 382 ó 96. Los años del siglo 
XXI y siguientes deben especificarse por completo, por ejemplo 2001, 3124 ó 40234. Los años 
anteriores al siglo XX también deben especificarse por completo, por ejemplo 382, 1798 ó 1492. 
Los años del siglo XX pueden especificarse con dos o cuatro dígitos, por ejemplo 96 ó 1996. Como 
un año especificado con dos dígitos corresponde al siglo XX, EViews no puede manejar fechas 
anteriores al año 100. 

� Datos trimestrales (Quarterly). Especificar el año, seguido por dos puntos (:) o un punto (.), seguido 
por el trimestre (de 1 a 4), por ejemplo 1960:3, 96:4 ó 2002:2. 

� Datos mensuales (Monthly). Especificar el año, seguido por dos puntos (:) o un punto (.), seguido 
por el mes (de 1 a 12), por ejemplo 1996:12, 96:12, 68:4 ó 2001:1. 
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05 INTRODUCCIÓN MANUAL DE DATOS 

EViews puede importar datos guardados en un archivo de texto (ASCII) o en una 
hoja de cálculo de Lotus o de Excel. La descripción de estas operaciones (así como la 
descripción de un procedimiento alternativo al que se explica en este apartado para 
introducir datos manualmente) se encuentra en Help → EViews Help Topics ... → Data 
Import and Export → Importing Data. En el caso de problemas pequeños, los datos pueden 
introducirse manualmente; para introducir manualmente los datos sobre la variable 
dependiente y sobre la variable explicativa del modelo RLS al que se refiere el 
ejercicio numérico que se hizo en clase al final del apartado 1.2, hay que crear dos 
series de datos (una para cada variable). Para la variable dependiente: 

1. Hacer clic en el botón  de la barra de botones del WF creado anteriormente y 
seleccionar New Object...: 

 

 

 

 

 

 

2. En la caja de diálogo New Object (que aparece tras el paso anterior), seleccionar 
Series en la lista Type of Object: (izquierda) y escribir Y (también vale cualquier otro 
nombre) en el campo Name for Object: (derecha): 

 

 

 

 

 

 

 

 

 

3. Hacer clic en el botón  de la caja de diálogo anterior. Tras esta operación, en el 
contenido del WF se muestra el objeto (la serie Y) que se acaba de crear, junto con 
los objetos C y RESID que siempre figuran en cualquier WF: 
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4. Hacer doble clic sobre la serie Y para ver su contenido. Dado que la serie Y se 
acaba de crear "partiendo de cero", todavía no contiene ningún dato (lo que se indica 
con las letras NA en los cinco componentes de que consta dicha serie). Para introducir 
los datos 84, 108, 92, 110 y 106, hacer clic en el botón  de la barra de botones de 
la ventana de la serie Y, hacer clic en la primera celda que contiene NA (a la derecha 
del número 1), escribir 84, y pulsar ENTER; escribir el siguiente dato (108), volver a 
pulsar ENTER, y repetir las mismas operaciones para los tres últimos datos (92, 110 y 
106); por último, hacer clic de nuevo en el botón  de la barra de botones de la 
ventana de la serie Y para finalizar la edición (modificación) de su contenido. La 
ventana de la serie Y debe presentar ahora el aspecto siguiente: 

 

 

 

 

 

 

 

 
Para introducir manualmente los datos sobre la variable explicativa, se siguen los  
mismos pasos anteriores: crear un nuevo objeto de tipo serie con el nombre X 
(también vale cualquier otro), que contenga los datos 32, 40, 36, 44 y 48. Después de 
crear la serie X, su ventana debe presentar el aspecto siguiente: 
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Por su parte, en el contenido del WF deben figurar ahora las dos series X e Y: 

 

 

 

 

 

 

 
Observación 4: Para cerrar la ventana que muestra el contenido de un objeto, hacer clic en el botón  
de su barra de título. En general, si se cierra la ventana de un objeto creado por EViews antes de darle 
un nombre, el programa ofrece la opción de dar un nombre a dicho objeto y almacenarlo en el WF en 
uso, o bien descartarlo (eliminarlo). Para abrir la ventana que muestra el contenido de un objeto, 
hacer doble clic sobre el nombre de dicho objeto en la lista de objetos presentes en el WF en uso. 

Observación 5: Para ver los nombres de los objetos contenidos en un WF con letras mayúsculas o 
minúsculas, hacer clic en el botón  de la barra de botones del WF y seleccionar Name Display → 
Uppercase o Lowercase, respectivamente. 

Además de la vista por defecto de una serie (la forma en la que se muestran las series 
Y y X en la página anterior), se pueden mostrar otras vistas de una serie haciendo clic 
en el botón  de su barra de botones y seleccionando la opción deseada del menú 
desplegable siguiente: 

 

 

 

 

 

 

Por ejemplo, seleccionando Descriptive Statistics → Histogram and Stats, en la ventana de 
la serie correspondiente se muestra un histograma y un cuadro con los valores 
calculados de algunos estadísticos muestrales de dicha serie; esta vista también puede 
obtenerse haciendo clic en el botón  (cuando está disponible) de la barra de 
botones de la serie. Por su parte, la vista por defecto (SpreadSheet en el menú 
desplegable anterior) de una serie puede obtenerse en cualquier momento haciendo 
clic en el botón  de su barra de botones. La descripción completa de las diferentes 
vistas de una serie se encuentra en Help → EViews Help Topics ... → Statistical Views and 
Procedures → Series Views. 

Observación 6: En general, la vista que presenta un objeto recién creado es su vista por defecto. No 
obstante, la vista que presenta un objeto al abrirlo es la misma que presentaba cuando se cerró por 
última vez (que puede no ser su vista por defecto). 
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06 ESPECIFICACIÓN Y ESTIMACIÓN POR MCO DE UN MODELO RLS 

Seleccionar Quick → Estimate Equation... del menú principal de EViews: 

 

 

 

 

 

 

 

En la sección Equation Specification: de la caja de diálogo Equation Specification, escribir: 
(1) el nombre de la serie que contiene los datos sobre la variable dependiente del 
modelo (Y en este caso), (2) al menos un espacio en blanco seguido por una C (que 
EViews interpreta como una serie de unos, para que el modelo tenga término 
constante), y (3) al menos un espacio en blanco seguido por el nombre de la serie que 
contiene los datos sobre la variable explicativa del modelo (X en este caso): 

 

 

 

 

 

 

 

 

Observación 7: En la sección Estimation Settings: de la caja de diálogo anterior figuran el método de 
estimación (mínimos cuadrados, en inglés LS - Least Squares) y la muestra (en inglés Sample) que se 
utilizarán para estimar el modelo (en este caso, la muestra comprende desde la primera observación 
hasta la quinta, es decir, todas las observaciones disponibles); en la mayoría de las ocasiones, no es 
necesario modificar ninguno de estos dos campos. 

Si se hace clic en el botón  de la caja de diálogo anterior, EViews estima el modelo 
especificado por MCO, coloca los resultados en un objeto de tipo modelo o ecuación 
(en inglés equation), y presenta la vista por defecto de dicho modelo en una nueva 
ventana: 
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Los dos números en la columna Coefficient de la tabla que figura en esta ventana son 
las estimaciones MCO del término constante (el parámetro asociado con la serie C) y 
de la pendiente (el parámetro asociado con la serie X) del modelo lineal simple 
especificado anteriormente: 

 

 

 

Los números Sum squared resid, Mean dependent var y S.D. dependent var son la suma 
residual de cuadrados, y la media y la desviación típica muestrales de la serie que 
contiene los datos sobre la variable dependiente. En clase se explicará qué son los 
otros números de la ventana anterior; ver también el apartado 10 de este documento. 

 

El modelo estimado se puede guardar dentro del WF creado anteriormente haciendo 
clic en el botón  de la barra de botones de la ventana anterior y escribiendo un 
nombre (por ejemplo MCO1) en el campo Name to identify object: de la caja de diálogo 
Object Name: 

 

 

 

 

 

 

Al hacer clic en el botón  de esta caja de diálogo, la barra superior de la ventana 
que contiene el modelo estimado muestra (en vez de UNTITLED) el nombre que se le ha 
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asignado (MCO1) al modelo; al mismo tiempo, el contenido del WF muestra ahora la 
ecuación MCO1: 

 

 

 

 

 

 

El icono  a la izquierda de MCO1 indica que MCO1 es un objeto de tipo ecuación (un 
modelo estimado); como en el caso de cualquier objeto contenido en un WF, si se 
hace doble clic sobre él se muestra su contenido en una ventana: 

 

 

 

 

 

 

 

 

 

 

Además de esta vista por defecto (que puede obtenerse en cualquier momento 
haciendo clic en el botón  de la barra de botones de la ventana anterior), se 
pueden obtener otras vistas de cualquier modelo estimado (ecuación) haciendo clic en 
el botón  de su barra de botones y seleccionando la opción deseada del menú 
desplegable siguiente: 

 

 

 

 

 

Por ejemplo, seleccionando Actual, Fitted, Residual → Actual, Fitted, Residual Table, en la 
ventana de la ecuación MCO1 se muestra una tabla con los valores observados (Actual) 
y ajustados (Fitted) de la variable dependiente y los residuos (Residual): 
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Por otro lado, seleccionando Actual, Fitted, Residual → Actual, Fitted, Residual Graph del 
menú desplegable anterior, en la ventana de la ecuación MCO1 se muestra un gráfico 
con los valores observados y ajustados de la variable dependiente y los residuos: 

 

 

 

 

 

 

 

 

 

 

 

Esta vista también puede obtenerse en cualquier momento haciendo clic en el botón 
 de la barra de botones de la ventana de la ecuación. 

Si se desea conservar los valores ajustados y los residuos del modelo estimado (MCO1) 
en dos series que queden guardadas dentro del WF en uso, se puede escribir la 
instrucción 

MCO1.FIT YHAT1 

en la ventana de comandos de EViews y pulsar ENTER (para guardar los valores 
ajustados en una serie llamada YHAT1); a continuación se puede escribir la instrucción 

MCO1.MAKERESID RES1 

en la ventana de comandos de EViews y pulsar ENTER (para guardar los residuos en 
una serie llamada RES1). De esta forma, las series de valores ajustados y de residuos 
del modelo MCO1 quedan guardadas en el WF y se pueden manipular posteriormente 
como cualquier objeto de tipo serie. 

Observación 8: Aunque EViews siempre guarda los residuos del último modelo estimado en la serie 
RESID que figura en cualquier WF, es recomendable guardar explícitamente cualquier serie de residuos 
que se pretenda utilizar después de estimar un modelo. 
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En Help → EViews Help Topics ... → Estimation Methods → Ordinary Least Squares puede 
encontrarse información detallada sobre cómo especificar y estimar por MCO modelos 
lineales, sobre los estadísticos que calcula EViews al estimar un modelo por MCO, y 
sobre las diferentes vistas de un modelo estimado (ecuación). 

 

07 REPRESENTACIÓN GRÁFICA DE UN MODELO RLS ESTIMADO POR MCO 

Seleccionar Quick → Graph... del menú principal de EViews: 

 

 

 

 

 

 
 
En la caja de diálogo Series List escribir primero el nombre de la serie que contiene los 
datos sobre la variable explicativa del modelo (X en este caso), y después el nombre 
de la serie que contiene los datos sobre la variable dependiente (Y en este caso): 

 

 

 

 

 

 

 
(El orden en el que se escriben las series en esta caja de diálogo importa: siempre 
debe escribirse primero la serie que contiene los datos sobre la variable explicativa.) 
Hacer clic en el botón  y seleccionar Scatter Diagram en la lista Graph Type: de la caja 
de diálogo Graph: 
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Hacer clic en el botón  de la caja de diálogo anterior y marcar la casilla 
a la izquierda de Regression line en la sección Scatter Diagram: de la parte inferior 
derecha de la caja de diálogo Graph Options: 

 

 

 

 

 

 

 

 

 

 

 

Al hacer clic en el botón  de la caja de diálogo anterior, EViews presenta en una 
nueva ventana el gráfico siguiente: 

 

 

 

 

 

 

 

 

 

 

 

La nube de puntos representada está compuesta por los cinco pares de datos 
contenidos en las series X e Y. La recta representada es la recta de regresión ajustada 
por MCO a dicha nube de puntos, cuya expresión analítica, de acuerdo con las 
estimaciones que figuran en la tabla de la página 10, es ˆ 38 1.55i iy x= + . 

Este gráfico se puede guardar dentro del WF creado anteriormente haciendo clic en el 
botón  de la barra de botones de la ventana anterior y escribiendo un nombre 
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(por ejemplo GMCO1) en el campo Name to identify object: de la caja de diálogo Object 
Name. Al hacer clic en el botón  de dicha caja de diálogo, la barra superior de la 
ventana que contiene el gráfico muestra (en vez de UNTITLED) el nombre que se le ha 
asignado (GMCO1); al mismo tiempo, el contenido del WF muestra ahora el gráfico 
GMCO1: 

 

 

 

 

 

 

El icono  a la izquierda de GMCO1 indica que GMCO1 es un objeto de tipo gráfico; 
como en el caso de cualquier objeto contenido en un WF, si se hace doble clic sobre él 
se muestra su contenido en una ventana. 

 

08 GUARDAR, CERRAR Y ABRIR UN ARCHIVO DE TRABAJO 

Guardar (en inglés save) un WF creado con EViews permite recuperarlo (abrirlo, en 
inglés open) posteriormente para utilizado cuando se desee sin tener que crear todo su 
contenido de nuevo. Para guardar el WF creado en los apartados 04 - 07 anteriores, 
hacer clic en el botón  de su barra de botones; en la caja de diálogo SaveAs 

 

 

 

 

 

 

 

 

 

escribir en el campo Nombre de archivo: el nombre que se desea dar al WF (por ejemplo, 
Ectr1-EV01) y utilizar el campo Guardar en: para encontrar la carpeta en la que se desea 
guardar el WF; si se quiere que, posteriormente, EViews busque por defecto archivos 
de trabajo y programas en la carpeta en la que se va a guardar el WF, hacer clic en 
el recuadro a la izquierda de Update default directory (el directorio en el que, por defecto, 
EViews busca archivos de trabajo y programas, siempre figura en la línea de estado 
de la ventana de EViews; ver página 3); para guardar el WF y, en su caso, actualizar 
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el directorio por defecto, hacer clic en el botón . La ventana del WF presenta 
ahora el aspecto siguiente: 

 

 

 

 

 

 

En la barra de título de esta ventana figuran ahora el nombre del WF (en 
mayúsculas) y su localización exacta (en minúsculas) en el sistema de directorios o 
carpetas del ordenador que se está utilizando; nótese que, aunque no se especificó de 
manera explícita en la caja de diálogo SaveAs anterior, la localización exacta del WF 
incluye al final la extensión .wf1, ya que EViews siempre añade esta extensión al 
nombre de cualquier WF que se guarde siguiendo el procedimiento descrito. 

 

Para cerrar (en inglés close) un WF, hacer clic en el botón   del extremo derecho de 
su barra de título, o bien seleccionar File → Close del menú principal de EViews 
cuando la ventana del WF está activa. Después de ejecutar cualquiera de estas 
acciones, si el WF se ha modificado después de la última vez que se guardó, EViews 
ofrece la posibilidad de guardarlo de nuevo (modificado) con un aviso del tipo 

 

 

 

 

 

Para abrir (en inglés open) un WF creado con EViews, seleccionar File → Open → 
Workfile... del menú principal del programa 

 

 

 

 

 

y proporcionar la información que se solicita en una caja de diálogo como la siguiente: 
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09 GRUPOS 

En este apartado se emplea el WF Num02-Anscombe.wf1 (disponible dentro del archivo 
comprimido Ectr1-JAM-Datos.zip en http://www.ucm.es/info/ecocuan/jam/ectr1) para ilustrar la 
creación y el manejo de grupos en EViews: 

 

 

 

 

 

 
Observación 9: Para abrir el WF Num02-Anscombe.wf1, seguir las indicaciones del final del apartado 
anterior. El WF Num02-Anscombe.wf1 se encontrará en la carpeta en la que se haya extraído todo el 
contenido del archivo comprimido Ectr1-JAM-Datos.zip. 

Un grupo en EViews es un conjunto de series. Un grupo resulta útil en particular 
para calcular rápidamente los estadísticos muestrales básicos de cada serie y para 
calcular las covarianzas y las correlaciones simples muestrales entre cada par de series 
del grupo. En el caso de series temporales, también puede resultar útil representar en 
uno o en varios gráficos todas las series del grupo. 

Para crear un grupo formado por las series Y1, Y2, Y3 y X1 del WF anterior, hacer clic 
sobre la primera serie (Y1) y, manteniendo pulsada la tecla CTRL, hacer clic sobre 
cada una de las series restantes (Y2, Y3 y X1). A continuación, soltar la tecla CTRL, 
hacer doble clic en cualquier lugar de la zona marcada y seleccionar la opción Open 
Group del menú desplegable que aparece en pantalla: 
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EViews presenta en una nueva ventana la vista por defecto del grupo recién creado: 

 

 

 

 

 

 

 

Además de la vista por defecto de un grupo, se pueden mostrar otras vistas de dicho 
grupo haciendo clic en el botón  de su barra de botones y seleccionando la opción 
deseada del menú desplegable siguiente: 

 

 

 

 

 

 

 

 

Por ejemplo, seleccionando Descriptive Stats → Common Sample, la ventana del grupo 
anterior muestra una tabla con los estadísticos muestrales básicos de cada serie del 
grupo; esta vista también puede obtenerse haciendo clic en el botón  (cuando está 
disponible) de la barra de botones del grupo. Si se selecciona Correlations en el menú 
desplegable anterior, la ventana del grupo muestra la matriz de correlaciones simples 
muestrales entre cada par de series del grupo; y si se selecciona Covariances, la 
ventana del grupo muestra la matriz de covarianzas muestrales entre cada par de 
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series del grupo. La vista por defecto (Spreadsheet en el menú desplegable anterior) de 
un grupo puede obtenerse en cualquier momento haciendo clic en el botón  de su 
barra de botones. La descripción completa de las diferentes vistas de un grupo se 
encuentra en Help → EViews Help Topics ... → Statistical Views and Procedures → Group Views 
and Procs. 

Un grupo de series como el anterior puede guardarse en el WF en uso haciendo clic 
en el botón  de la barra de botones del grupo y escribiendo un nombre (por 
ejemplo GRP1) en el campo Name to identify object: de la caja de diálogo Object Name. Al 
hacer clic en el botón  de dicha caja de diálogo, la barra superior de la ventana 
que contiene el grupo muestra (en vez de UNTITLED) el nombre que se le ha asignado 
(GRP1); al mismo tiempo, el contenido del WF en uso muestra ahora el grupo GRP1 
en su lista de objetos: 

 

 

 

 

 

 

El icono  a la izquierda de GRP1 indica que GRP1 es un objeto de tipo grupo de 
series; como en el caso de cualquier objeto contenido en un WF, si se hace doble clic 
sobre él se muestra su contenido en una ventana. 

EViews también permite agrupar varios objetos de tipo gráfico en un sólo gráfico 
mediante un procedimiento muy similar al descrito anteriormente para crear un 
grupo de series. Sin embargo, a diferencia de lo que ocurre al agrupar varias series, el 
resultado de agrupar varios gráficos es un objeto de tipo gráfico, no de tipo grupo. 
Por ejemplo, el gráfico que figura en la página siguiente (compuesto por cuatro 
gráficos individuales) puede obtenerse realizando las siguientes operaciones: 

1. Elaborar un gráfico del tipo descrito en el apartado 07 anterior para cada uno de 
los cuatro pares de series siguientes: Y1, X1; Y2, X1; Y3, X1; Y4, X2. Nombrar los cuatro 
gráficos GRAF1, GRAF2, GRAF3 y GRAF4, respectivamente. 

2. En la lista de objetos del WF, hacer clic sobre el gráfico GRAF1 y, manteniendo 
pulsada la tecla CTRL, hacer clic sobre cada uno de los gráficos restantes (GRAF2, 
GRAF3 y GRAF4). A continuación, soltar la tecla CTRL y hacer doble clic sobre 
cualquier lugar de la zona marcada. 

3. Para que la escala de los cuatro gráficos sea la misma, hacer clic con el botón 
derecho del ratón en cualquier lugar del gráfico, seleccionar la opción Scaling on all 
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graphs... del menú desplegable que aparece en pantalla, e introducir la información que 
está recogida en la caja de diálogo Multiple Graph Scales siguiente: 

 

 

 

 

 

 

 

4. Hacer clic en el botón  de la caja de diálogo anterior. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Este gráfico puede guardarse en el WF en uso siguiendo las indicaciones que figuran 
al final del apartado 07 anterior. En Help → EViews Help Topics ... → EViews Basics → 
Working with Graphs puede encontrarse información detallada sobre la creación y el 
manejo de gráficos (individuales y agrupados) en EViews. 
Observación 10: Los cuatro gráficos de la ventana anterior resultan muy útiles para ilustrar la idea de 
que, en la práctica, los resultados numéricos derivados de la estimación por MCO de un modelo lineal 
no contienen, en general, toda la información necesaria para decidir si el modelo estimado describe 
adecuadamente la procedencia de los datos disponibles sobre la variable dependiente del modelo; ver la 
Observación 12 al final del apartado 10 de este documento. 
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Observación 11: Tanto una tabla de resultados numéricos (como la contenida en la vista por defecto de 
un modelo estimado, o la contenida en la vista Descriptive Stats → Common Sample de un grupo de series) 
como un gráfico (individual o agrupado), pueden ser copiados desde EViews a un documento de 
Microsoft Word (o de cualquier procesador de textos para Windows). Para copiar una tabla de 
resultados numéricos (o una parte de ella) desde EViews a Microsoft Word: 

T1. En EViews, mostrar y activar la vista del objeto que contiene la tabla que se desea copiar. 

T2. Pulsar el botón izquierdo y arrastrar el ratón para seleccionar la tabla o la parte de la tabla que 
se desea copiar. 

T3. Soltar el botón izquierdo del ratón, hacer clic con el botón derecho en cualquier parte del área 
seleccionada, y seleccionar Copy en el menú desplegable siguiente: 

 

 

A continuación, seleccionar Formatted – Copy numbers as they appear in table y pulsar el botón  en la 
caja de diálogo Copy Precision siguiente: 

 

 

 

 

T4. En Word, pulsar CTRL+V (pegar) y darle a la tabla el formato deseado. Por ejemplo, la tabla 
siguiente (que contiene la estimación por MCO de la regresión con término constante de Y1 sobre 
X1) se ha obtenido a partir de la tabla copiada de EViews centrándola, fijando el tipo de letra en 
Arial 8 puntos, autoajustándola a su contenido, añadiéndole la línea doble superior, y 
eliminándole la fila de la fecha y la hora que siempre incluye EViews: 

Dependent Variable: Y1 
Method: Least Squares 
Sample: 1 11 
Included observations: 11 

Variable Coefficient Std. Error t-Statistic Prob. 

C 3.000091 1.124747 2.667348 0.0257
X1 0.500091 0.117906 4.241455 0.0022

R-squared 0.666542     Mean dependent var 7.500909
Adjusted R-squared 0.629492     S.D. dependent var 2.031568
S.E. of regression 1.236603     Akaike info criterion 3.425579
Sum squared resid 13.76269     Schwarz criterion 3.497924
Log likelihood -16.84069     F-statistic 17.98994
Durbin-Watson stat 3.212290     Prob(F-statistic) 0.002170

Para copiar un gráfico desde EViews a Word: 

G1. En EViews, mostrar y activar la ventana que contiene el gráfico que se desea copiar. 

G2. Pulsar CTRL+C (copiar), seleccionar Copy to clipboard (quizás también Use Color) y pulsar el botón  
en la caja de diálogo Copy Graph as Metafile que figura en la página siguiente. 

G3. En Word, seleccionar a partir del menú principal Edición → Pegado especial... → Pegar: Como: Imagen y 
darle al gráfico el formato deseado. 

Dependiendo del gráfico que se desee copiar desde EViews, el paso G3 anterior (que siempre funciona 
bien) puede no ser equivalente a pulsar CTRL+V (pegar) en Word (que no siempre funciona bien). 
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10 ESTADÍSTICOS ASOCIADOS CON LA ESTIMACIÓN DE UN MODELO POR MCO 

El contenido del WF Ectr1-EV01.wf1 creado en los apartados 04 - 08 anteriores es el 
siguiente: 

 

 

 

 

 

 

La vista por defecto del modelo estimado MCO1 es la siguiente: 

 

 

 

 

 

 

 

 

 

 
A continuación se describen algunos elementos numéricos de esta tabla (ver también 
el apartado 06 anterior): 

¹ La columna Coefficient (coeficiente o parámetro) contiene las estimaciones MCO de 
los parámetros asociados con las variables explicativas C y X. Dichos parámetros 
son el término constante y la pendiente, respectivamente, de la regresión lineal 
con término constante de Y sobre X. 
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¹ La columna Std. Error (error estándar) contiene los errores estándar (desviaciones 
típicas estimadas) de los estimadores MCO de los parámetros asociados con las 
variables explicativas C y X. Los errores estándar son las raíces cuadradas de los 
elementos en la diagonal principal de la matriz de varianzas estimada del 
estimador MCO; dicha matriz puede verse (completa) seleccionando Covariance 
Matrix después de pulsar el botón  en la ventana de la ecuación MCO1: 

 

 

 

 

¹ La columna t-Statistic (estadístico t) contiene los cocientes entre la estimación 
MCO de cada parámetro y el error estándar del estimador MCO correspondiente. 
Estas cantidades sirven para contrastar (como se explica en el Tema 2 del 
programa de la asignatura) ciertas hipótesis sobre los verdaderos valores de los 
parámetros correspondientes. 

¹ La columna Prob. (probabilidad) contiene los niveles de significación marginales 
(p-values) para los contrastes a los se refiere el punto anterior (cuyo uso se explica 
en el Tema 2 del programa de la asignatura). 

¹ R-squared y Adjusted R-squared son los coeficientes de determinación normal y 
ajustado, respectivamente. 

¹ S.E. of regression (error estándar de la regresión) es la raíz cuadrada de la 
estimación MCO de la varianza de las perturbaciones. 

¹ Sum squared resid (suma residual de cuadrados) es la suma de los cuadrados de los 
residuos MCO (es decir, el numerador de la estimación MCO de la varianza de las 
perturbaciones). 

¹ Mean dependent var (media de la variable dependiente) es la media muestral de la 
serie que contiene las observaciones sobre la variable dependiente del modelo (es 
decir, el cociente entre la suma de los valores observados sobre la variable 
dependiente y el tamaño muestral). 

¹ S.D. dependent var (desviación típica de la variable dependiente) es la raíz cuadrada 
de la cuasivarianza muestral de la serie que contiene las observaciones sobre la 
variable dependiente del modelo (es decir, la raíz cuadrada del cociente entre la 
suma total de cuadrados y el tamaño muestral menos 1). 

En el apartado Equation Output de la ayuda disponible en Help → EViews Help Topics ... → 
Estimation Methods → Ordinary Least Squares puede encontrarse información detallada 
sobre todos los estadísticos que calcula EViews al estimar un modelo por MCO. Los 
valores de dichos estadísticos son almacenados internamente por EViews y se puede 
acceder a su contenido (para utilizarlo, por ejemplo, como parte de una instrucción en 
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la ventana de comandos de EViews; ver apartado 12) como se describe en el apartado 
Working With Regression Statistics de la ayuda disponible en Help → EViews Help Topics ... 
→ Estimation Methods → Ordinary Least Squares. 
Observación 12: La idea de que los resultados numéricos derivados de la estimación por MCO de un 
modelo lineal no contienen, en general, toda la información necesaria para decidir si el modelo 
estimado describe adecuadamente la procedencia de los datos disponibles sobre la variable dependiente, 
puede ilustrarse comparando entre sí las estimaciones por MCO de las cuatro regresiones asociadas con 
los cuatro gráficos creados en el apartado 09 anterior. Ver también las preguntas 6 a 10 del examen 
final de Econometría I del día 5/9/01 (curso 2000/01). 

 

11 ESTIMACIÓN POR MCO DE MODELOS NO LINEALES EN LAS VARIABLES 

En los ejemplos siguientes se ilustra cómo estimar por MCO distintos modelos de 
regresión lineal que incluyen entre sus variables algunas transformaciones no lineales 
de las variables originales de interés. 

Ejemplo 1: 

Utilizando los datos del WF SC01-RecienNacidos.wf1 se han estimado por MCO los dos 
modelos siguientes: 

 1 2i i iPESO CIGM Uβ β= + +  [1.1] 

 1 2ln i i iPESO CIGM Uβ β= + +  [1.2] 

Una vez abierto con EViews el WF SC01-RecienNacidos.wf1, para estimar el modelo 
[1.1] seleccionar Quick → Estimate Equation... del menú principal de EViews y escribir 
PESO C CIGM en la sección Equation Specification: de la caja de diálogo Equation 
Specification. Para estimar el modelo [1.2] seleccionar Quick → Estimate Equation... del 
menú principal de EViews y escribir LOG(PESO) C CIGM en la sección Equation 
Specification: de la caja de diálogo Equation Specification. A continuación se presenta un 
resumen de los dos modelos estimados: 

 
2 2

ˆ3392.06 14.38 ,
(15.90) (2.51)

ˆ1387,  0.0231,  0.0224,  559.10 .

i i ipeso cigm u

N R R σ

= − +

= = = =
 [1.1]′ 

 
2 2

ˆln 8.1134 0.0045 ,
(0.0053) (0.0008)

ˆ1387,  0.0198,  0.0190,  0.1876 .

i i ipeso cigm u

N R R σ

= − +

= = = =
 [1.2]′ 

Observación 13: La forma descrita anteriormente para estimar el modelo [1.2] con EViews implica, en 
general, que para estimar un modelo en el que interviene alguna transformación de alguna serie 
original, no es necesario (ni, en muchos casos, recomendable) previamente crear una serie nueva 
transformando dicha serie original. En Help → EViews Help Topics ... → EViews Basics → Working with Series y en 
Help → EViews Help Topics ... → EViews Basics → Using Expressions puede encontrarse información detallada 
sobre cómo crear series nuevas en EViews a partir de series contenidas en un WF; por otro lado, en 
Help → Function Reference figura un listado completo de los operadores y de las funciones que pueden 
emplearse en EViews para crear y modificar series; ver también el apartado 12 de este documento. 
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Ejemplo 2: 

Utilizando los datos del WF SC04-Salarios-Wool-1.wf1 se han estimado por MCO los 
tres modelos siguientes: 

 1 2 3i i i iWAGE EDUC EXPER Uβ β β= + + +  [2.1] 

 2
1 2 3 4ln i i i iiWAGE EDUC EXPER EXPER Uβ β β β= + + + +  [2.2] 

 
2

1 2 3 4

5

ln

                      ( )
i i i i

i i i

WAGE EDUC EXPER EXPER

EDUC EXPER U

β β β β

β

= + + +

+ × +
 [2.3] 

Una vez abierto con EViews el WF SC04-Salarios-Wool-1.wf1, para estimar el modelo 
[2.1] seleccionar Quick → Estimate Equation... del menú principal de EViews y escribir 
WAGE C EDUC EXPER en la sección Equation Specification: de la caja de diálogo Equation 
Specification. Para estimar el modelo [2.2] seleccionar Quick → Estimate Equation... del 
menú principal de EViews y escribir LOG(WAGE) C EDUC EXPER EXPER^2 en la sección 
Equation Specification: de la caja de diálogo Equation Specification. Para estimar el modelo 
[2.3] seleccionar Quick → Estimate Equation... del menú principal de EViews y escribir 
LOG(WAGE) C EDUC EXPER EXPER^2 (EDUC * EXPER) en la sección Equation Specification: 
de la caja de diálogo Equation Specification. A continuación se presenta un resumen de 
los tres modelos estimados: 

 
2 2

ˆ3.39 0.64 0.07 ,
(0.77) (0.05) (0.01)

ˆ526,  0.2252,  0.2222,  3.26 .

i i i iwage educ exper u

N R R σ

= − + + +

= = = =
 [2.1]′ 

 
2

2 2

ln 0.1280 0.0904 0.0410
(0.1059) (0.0075) (0.0052)

ˆ0.0007 ,
(0.0001)

ˆ526,  0.3003,  0.2963,  0.4459 .

i i i

i i

wage educ exper

exper u

N R R σ

= + +

− +

= = = =

 [2.2]′ 

 
2

2 2

ln 0.2328 0.1171 0.0615
(0.1705) (0.0124) (0.0092)

ˆ0.0008 0.0014( ) ,
(0.0001) (0.0005)

ˆ526,  0.3099,  0.3046,  0.4433 .

i i i

i i i i

wage educ exper

exper educ exper u

N R R σ

= − + +

− − × +

= = = =

 [2.3]′ 

Ejemplo 3: 

Utilizando los datos del WF ST03-FProNovales.wf1 se ha estimado por MCO el modelo 
siguiente (una función de producción de tipo Cobb-Douglass): 

 1 2 3ln ln lnt t t tPIB TRABAJO CAPITAL Uβ β β= + + +  [3.1] 
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Una vez abierto con EViews el WF ST03-FProNovales.wf1, para estimar el modelo [3.1] 
seleccionar Quick → Estimate Equation... del menú principal de EViews y escribir 
LOG(PIB) C LOG(TRABAJO) LOG(CAPITAL) en la sección Equation Specification: de la caja de 
diálogo Equation Specification. A continuación se presenta un resumen del modelo 
estimado: 

 
2 2

ˆln 0.0091 0.3216 ln 0.6304 ln ,
(1.0531) (0.1059) (0.0131)

ˆ25,  0.9916,  0.9908,  0.0249 .

t t t tpib trabajo capital u

N R R σ

= + + +

= = = =
 [3.1]′ 

Observación 14: En la práctica, es frecuente obtener valores altos para el coeficiente de determinación 
en modelos estimados con series temporales, sobre todo si dichas series presentan tendencias 
semejantes. En muchos casos, estas situaciones reflejan que las regresiones estimadas son espurias, ya 
que sugieren la existencia de relaciones significativas debido tan sólo a la presencia de tendencias 
semejantes en las variables consideradas, no a una relación real entre dichas variables. 

Ejemplo 4: 

Utilizando los datos del WF ST06-Trigo.wf1 se han estimado por MCO los dos modelos 
siguientes: 

 1 2ln lnt t tQ P Uβ β= + +  [4.1] 

 1 2 3ln lnt t tQ P t Uβ β β= + + +  [4.2] 

Una vez abierto con EViews el WF ST06-Trigo.wf1, para estimar el modelo [4.1] 
seleccionar Quick → Estimate Equation... del menú principal de EViews y escribir LOG(Q) 
C LOG(P) en la sección Equation Specification: de la caja de diálogo Equation Specification. 
Para estimar el modelo [1.2] seleccionar Quick → Estimate Equation... del menú principal 
de EViews y escribir LOG(Q) C LOG(P) T en la sección Equation Specification: de la caja de 
diálogo Equation Specification. A continuación se presenta un resumen de los dos 
modelos estimados: 

 
2 2

ˆln 4.9472 0.6213 ln ,
(0.0631) (0.0760)

ˆ26,  0.7359,  0.7249,  0.1068 .

t t tq p u

N R R σ

= + +

= = = =
 [4.1]′ 

 
2 2

ˆln 5.0420 0.2425 ln 0.0150 ,
(0.0745) (0.1948) (0.0072)

ˆ26,  0.7780,  0.7587,  0.1000 .

t t tq p t u

N R R σ

= + + +

= = = =
 [4.2]′ 

Observación 15: Las series LOG(Q) y LOG(P) presentan ambas una tendencia determinista semejante 
(ver el gráfico de la página siguiente) que provoca al estimar [4.1] la aparente existencia de una 
relación muy significativa. Sin embargo, una vez extraída la tendencia de ambas series (por medio 
simplemente de la inclusión de una variable explicativa t = 1, 2, ..., 26 en [4.2]), la elasticidad 
estimada en [4.2]′ resulta notablemente menor que la estimada en [4.1]′ y, en todo caso, dicha 
elasticidad no parece estadísticamente significativa. (El concepto de significación estadística se explica 
en el Tema 2 del programa de la asignatura.) 
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Observación 16: Este gráfico (compuesto por dos gráficos individuales) se ha copiado desde EViews a 
Microsoft Word siguiendo los pasos G1-G3 del final del apartado 09 anterior. Para crear este gráfico 
con EViews, en el WF ST06-Trigo.wf1 realizar las operaciones siguientes: 

1. Seleccionar Quick → Graph... del menú principal de EViews. En la caja de diálogo Series List, escribir T 
LOG(Q) y hacer clic en el botón . Seleccionar Scatter Diagram en la lista Graph Type: de la caja de 
diálogo Graph, hacer clic en el botón  de dicha caja de diálogo, y rellenar las secciones 
Graph Scaling: y Scatter Diagram: de la caja de diálogo Graph Options como se muestra a continuación: 

 

 

 

 

 

 

 

 

 

 
Hacer clic en el botón  de la caja de diálogo anterior y nombrar el gráfico resultante G1. Este 
gráfico representa la estimación por MCO de la regresión lineal con término constante de LOG(Q) 
sobre T, es decir, la estimación por MCO de una tendencia lineal determinista para LOG(Q). Dicha 
estimación puede representarse como ˆln 5.120 0.023 t tq t v= + +  (como puede comprobarse al 
estimar en EViews la regresión con término constante de LOG(Q) sobre T). 

2. Seleccionar Quick → Graph... del menú principal de EViews. En la caja de diálogo Series List, escribir T 
LOG(P) y hacer clic en el botón . Seleccionar Scatter Diagram en la lista Graph Type: de la caja de 
diálogo Graph, hacer clic en el botón  de dicha caja de diálogo, y rellenar las secciones 
Graph Scaling: y Scatter Diagram: de la caja de diálogo Graph Options como se muestra en la página 
siguiente. Hacer clic en el botón  de dicha caja de diálogo y nombrar el gráfico resultante G2. 
Este gráfico representa la estimación por MCO de la regresión lineal con término constante de 
LOG(P) sobre T, es decir, la estimación por MCO de una tendencia lineal determinista para LOG(P). 
Dicha estimación puede representarse como ˆln 0.321 0.034 t tp t v= + +  (como se puede 
comprobar al estimar en EViews la regresión con término constante de LOG(P) sobre T). 
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3. En la lista de objetos del WF, hacer clic sobre el gráfico G1 y, manteniendo pulsada la tecla CTRL, 
hacer clic sobre el gráfico G2. A continuación, soltar la tecla CTRL y hacer doble clic sobre 
cualquier lugar de la zona marcada. Para que los dos gráficos aparezcan en fila en vez de en 
columna, hacer clic con el botón derecho del ratón en cualquier lugar del gráfico, seleccionar la 
opción Position and align graphs... del menú desplegable que aparece en pantalla, e introducir la 
información que está recogida en la caja de diálogo Multiple Graph Alignment siguiente: 

 

 

 

 

 

4. Hacer clic en el botón  de la caja de diálogo anterior y nombrar (si se desea guardar en el WF) 
el gráfico resultante (que es el que aparece copiado al principio de la página anterior). 

 

12 OTRAS OPERACIONES 

En este apartado se emplean los WFs ST07-Bolsa.wf1 y ST08-TintBanca (disponibles en 
el archivo comprimido Ectr1-JAM-Datos.zip en http://www.ucm.es/info/ecocuan/jam/ectr1) para 
ilustrar otras operaciones básicas (copiar objetos de un WF a otro, crear series, 
utilizar la ventana de comandos, ...) que pueden realizarse en EViews: 
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Copiar una serie de un WF a otro: 

Para copiar la serie TINT del WF ST08-TintBanca.wf1 al WF ST07-Bolsa.wf1, abrir en una 
única sesión (ventana) de EViews los dos WFs. En la ventana del WF ST08-
TintBanca.wf1, hacer clic con el botón derecho del ratón sobre la serie TINT y seleccionar 
Copy (copiar) en el menú desplegable que aparece en pantalla. A continuación, activar 
la ventana del WF ST07-Bolsa.wf1 y pulsar CTRL+V (pegar) en el teclado. El contenido 
del WF ST07-Bolsa.wf1 queda actualizado como se muestra a continuación: 

 

 

 

 

 
Observación 17: Dado que el rango del WF ST07-Bolsa.wf1 (1987:01 2002:12) es menor que el del WF 
ST08-TintBanca.wf1 (1978:01 2002:12), la serie TINT que figura en el WF ST07-Bolsa.wf1 no contiene las 
primeras observaciones (1978:01 1986:12) que sí tenía en su WF de origen. En el apartado Copying 
Objects de la ayuda disponible en Help → EViews Help Topics ... → EViews Basics → Object Basics puede 
encontrarse información detallada sobre cómo copiar objetos en general de un WF a otro. 

Observación 18: El WF ST08-TintBanca.wf1 no se utiliza más en este apartado, por lo que puede cerrarse 
después de completar la operación anterior. En el resto de este apartado se sigue utilizando el WF 
ST07-Bolsa.wf1 a partir de como figura en la imagen anterior. 

Crear series: 

Para crear o generar una serie nueva dentro de un WF a partir de alguna expresión o 
ecuación matemática (que generalmente incluye alguna/s serie/s ya existente/s en 
dicho WF), seleccionar Quick → Generate Series... del menú principal de EViews, o bien 
hacer clic en el botón  de la barra de botones del WF. En ambos casos, 
proporcionar a continuación la información que se solicita en una caja de diálogo 
Generate Series by Equation como la de la página siguiente. 

Por ejemplo, para crear dentro del WF ST07-Bolsa.wf1 anterior una serie con el 
nombre LIBEX35 que contenga el logaritmo neperiano de la serie IBEX35, escribir 

LIBEX35 = LOG( IBEX35 ) 

en la sección Enter equation: de la caja de diálogo Generate Series by Equation, modificar 
(si no es adecuado el que ofrece EViews por defecto) el intervalo muestral en la 
sección Sample:, y hacer clic en el botón  de dicha caja de diálogo. 
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También pueden crearse series de forma más directa usando la ventana de comandos 
de EViews. Por ejemplo, para crear la serie LIBEX35 anterior, escribir la instrucción 

SERIES LIBEX35 = LOG( IBEX35 ) 

en la ventana de comandos de EViews y pulsar ENTER (la palabra clave SERIES al 
principio de la instrucción anterior es equivalente a la palabra clave GENR). En Help 
→ Function Reference figura un listado completo de los operadores y de las funciones 
que pueden emplearse en EViews para crear y modificar series. Por ejemplo, la 
instrucción 

SERIES STIBEX35 = ( IBEX35 – @MEAN( IBEX35 ) ) / SQR( @VAR( IBEX35 ) ) 

crea una serie llamada STIBEX35 que contiene la serie IBEX35 estandarizada, mientras 
que las instrucciones 

SERIES TCVIBEX35 = 100 * ( IBEX35 – IBEX35( –1 ) ) / IBEX35 
SERIES TLVIBEX35 = 100 * LOG( IBEX35 / IBEX35( –1 ) ) 

crean dos series llamadas TCVIBEX35 y TLVIBEX35 que contienen las tasas porcentuales 
convencional y logarítmica, respectivamente, de variación mensual de la serie IBEX35. 

Para crear una serie de tendencia con el nombre T (como la utilizada en el Ejemplo 4 
del apartado 11 anterior), escribir la instrucción 

SERIES T = @TREND + 1 

en la ventana de comandos de EViews y pulsar ENTER. 

Eliminar y renombrar objetos: 

Para eliminar un objeto de un WF, hacer clic con el botón derecho del ratón sobre su 
nombre en la lista de objetos del WF y seleccionar la opción Delete (eliminar) en el 
menú desplegable que aparece en pantalla.  Para cambiar el nombre de un objeto de 
un WF, hacer clic con el botón derecho del ratón sobre su nombre en la lista de 
objetos del WF y seleccionar la opción Rename... (renombrar) en el menú desplegable 
que aparece en pantalla. 
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Otros usos de la ventana de comandos: 

En general, las operaciones llevadas a cabo de forma interactiva (seleccionando 
opciones y rellenando cajas de diálogo) en todos los apartados anteriores, se pueden 
llevar a cabo de forma más rápida y directa utilizando la ventana de comandos de 
EViews. Los ejemplos siguientes parten del contenido del WF ST07-Bolsa.wf1 que 
figura en la segunda imagen de la página 29. 

La instrucción 

GROUP GRP1 LOG( IBEX35 ) TINT 

crea un grupo llamado GRP1 formado por las series LOG( IBEX35 ) y TINT. 

Las instrucciones 

GRAPH GRAF1.LINE LOG( IBEX35 ) 
GRAPH GRAF2.LINE TINT 
GRAPH GRAF3.MERGE GRAF1 GRAF2 

crean tres gráficos llamados GRAF1, GRAF2 y GRAF3 que contienen, respectivamente, 
un gráfico temporal de la serie LOG( IBEX35 ), un gráfico temporal de la serie TINT, y 
un gráfico agrupado de los dos anteriores (ver página siguiente). 

La instrucción 

GRAPH GRAF4.SCAT( R ) TINT LOG( IBEX35 ) 

crea un gráfico llamado GRAF4 que contiene un diagrama de tipo scatter con TINT en 
el eje horizontal y LOG( IBEX35 ) en el eje vertical; el gráfico también contiene una 
representación de la estimación por MCO de la regresión con término constante de 
LOG( IBEX35 ) sobre TINT (ver página siguiente). Esta regresión se puede estimar y 
guardar en un objeto de tipo ecuación con el nombre M4 escribiendo la instrucción 

EQUATION M4.LS LOG( IBEX35 ) C TINT 

en la ventana de comandos de EViews y pulsando ENTER (ver página siguiente). 
Observación 19: Las series LOG( IBEX35 ) y TINT presentan ambas una tendencia estocástica semejante  
(ver el gráfico GRAF3 de la página siguiente) que provoca (como se observa en el modelo M4 y en el 
gráfico GRAF4 de la página siguiente) la aparente existencia de una relación muy significativa (como en 
el Ejemplo 4 del apartado 11). La regresión que figura estimada en M4 es espuria (ya que sugiere la 
existencia de una relación significativa debido tan sólo a la presencia de tendencias semejantes en las 
variables consideradas, no a una relación real entre dichas variables), aunque la detección de una 
situación de este tipo no es tan inmediata como en el Ejemplo 4 del apartado 11; esta cuestión se trata 
en la asignatura Econometría II. 

Crear números (escalares): 

Además de para otros fines (como los descritos anteriormente), la ventana de 
comandos de EViews puede utilizarse como una calculadora científica. Para evaluar 
una expresión matemática y guardar el resultado en un objeto de tipo escalar dentro 
de un WF, escribir una instrucción del tipo 

SCALAR NAME = EXPR 
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en la ventana de comandos de EViews y pulsar ENTER, donde NAME es el nombre que 
se desea dar al objeto de tipo escalar que contendrá el resultado de la expresión 
matemática EXPR. Por ejemplo, la instrucción 

SCALAR MIBEX35 = @MEAN( IBEX35 ) 

crea un escalar llamado MIBEX35 que contiene la media muestral de la serie IBEX35: 

 

 

 

 

 

 

 

El icono  a la izquierda de MIBEX35 indica que MIBEX35 es un objeto de tipo escalar 
(número); como en el caso de cualquier objeto contenido en un WF, si se hace doble 
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clic sobre él se muestra su contenido, aunque en este caso en la línea de estado de 
EViews (no en una ventana, como en el caso de una serie o de un gráfico): 

 

En Help → Function Reference figura un listado completo de los operadores y de las 
funciones que pueden emplearse en EViews para evaluar expresiones matemáticas 
cuyo resultado es un número (escalar). Por ejemplo, la instrucción 

SCALAR T2 = ABS( M4.@COEFS(2) / SQR( M4.@COV(2,2) ) ) 

crea un escalar llamado T2 que contiene el valor absoluto del estadístico t asociado 
con la pendiente del modelo estimado en la ecuación M4 (ver el apartado 10 anterior). 
Por su parte, cualquiera de las instrucciones 

SCALAR SIGMA2 = M4.@SE^2 
SCALAR SIGMA2 = M4.@SSR / ( M4.@REGOBS – M4.@NCOEF ) 

crea un escalar llamado SIGMA2 que contiene la estimación MCO de la varianza de las 
perturbaciones del modelo estimado en la ecuación M4: 

 

En el apartado Statistical Distribution Functions de la ayuda disponible en Help → 
Function Reference puede encontrarse información detallada sobre un amplio conjunto 
de funciones para calcular probabilidades y valores críticos a partir de las 
distribuciones N(0, 1), t de Student, Chi-Cuadrado ( 2χ ) y F. Estos cálculos resultan 
muy útiles para contrastar hipótesis en el contexto del MLG como se explica en el 
Tema 2 del programa de la asignatura. 

Por ejemplo, las instrucciones 

SCALAR PROBN = @CNORM( 2 ) 
SCALAR CRITN = @QNORM( 0.95 ) 

crean dos escalares llamados PROBN y CRITN que contienen, respectivamente, la 
probabilidad Pr[N(0, 1) 2]≤  y el valor crítico A tal que Pr[N(0, 1) ] 0.95A≤ = : 

 

 

Las instrucciones siguientes son semejantes a las dos anteriores: 

SCALAR PROBT = @CTDIST( 2, 20 ) Pr[ (20) 2]t ≤  
SCALAR CRITT = @QTDIST( 0.95, 20 ) : Pr[ (20) ] 0.95A t A≤ =  

SCALAR PROBF = @CFDIST( 2, 5, 20 ) Pr[ (5, 20) 2]F ≤  
SCALAR CRITF = @QFDIST( 0.95, 5, 20 ) : Pr[ (5, 20) ] 0.95A F A≤ =  

SCALAR PROBC = @CCHISQ( 2, 5 ) 2Pr[ (5) 2]χ ≤  
SCALAR CRITC = @QCHISQ( 0.95, 5 ) 2: Pr[ (5) ] 0.95A Aχ ≤ =  
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